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Economic Relevance

 [Embedded] Software

 Exponential increase LOC

« Despite thorough design / testing, constant fault density

o Typically 5-15bugs / KLOC, 75 min / bug » $4K/KLOC

* Development cost $15-30K / KLOC » 15-25% diagnostic cost
« Residual defects cost US $60B/year [NIST 2002]

« estimated 20% due to fault diagnosis (downtime, labor)



The birth of debugging: your.g;UeSS?



- E & |
HEE : 4
— : :
T g E
vor — = {03 =
! : = 3 13k -
& : 3 B EEE
! - 3 3 EE
re s — R - ¥X —
!'- _: : : ': :'j;’
‘ = Yy -
Y

Software Errors mentioned in Ada Byron’s notes on Charles
Bababage’'s analytical engine
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First actual bug and actual debugging: Admiral Grace
Hopper’'s associates working on Mark || Computer at Harvard
University

1840 1947 2015
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Static Slicing Example

Test Cases

Pass/Faii P P P P P |F

Weiser's Breakthrough paper.
Input: source code and program point

-
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| ../sysdeps/1386/elf/start.S: No such file or directory.
in ../sysdeps/i386/elf/start.S
gdb$ b main Notice from NickServ

Breakpoint 1 at Ox80483aa This nickname is registered. Please
gdb$ run choose a different nickname, or

EAX: BFFFFS5FC EBX: B7FCAFFC ECX: B7FCD19C EDX: 00000001 o d I t S z a P
ESI: BFFFFS5F4 EDI: BFFFF580 EBP: BFFFF568 ESP: BFFFF550 EIP: @BO4B3AA
CS: @973 DS: 007B ES: 097B FS: 0000 GS: 0033 SS: ee7s
[@@7B:BFFFF550)
BFFFF5A® 20 00
BFFFF59@ 70 FS
BFFFF580 FC AF
BFFFF570 o1 @0
BFFFF560 20 @0
BFFFFS55@ FC AF
[@@7B:BFFFF550)
BFFFF55@ FC AF
BFFFF560 : 20 @9 cessccssccccclles
BFFFF57@ o1 ee cecsscssccccdfes
BFFFF580 FC AF csssssssssssssss
BFFFF59@ 70 F5 PeeceMecccssccsese
BFFFFSA® 20 @9 ssssssssssssssss
BFFFFSB® 20 29 sovcelocefocesse
BFFFF5Ce : o1 @0 cessecssesnscess
[@©73:080483AA)
Ox80483aa <main+6>: esp,exfffffffe
Ox88483ad <main+9>: eax,oxe
0x88483b2 <main+l14>: eax,oxf
Ox80483b5 <main+l17>: eax,oxf
Ox80483b8 <main+20>: ecax,ox4
Ox80483bb <main+23>: eax,ox4
Ox80483be <main+26>: esp,eax
Ox80483cO <main+28>: eax,ds:0xB0484f4
Ox88483c5 <main+33>: DWORD PTR [ebp-24],eax
Ox80483c8 <main+36>: al,ds:0xB0484f8
0x80483cd <main+dl>: BYTE PTR [ebp-20],al
Ox80483d0 <main+dd>: esp,oxc
Ox80483d3 <main+d7>: Ox80484F9
Ox80483d8 <main+52>: Ox80482b8 <printf@plt>
Ox80483dd <main+57>: esp,ox1e
<main+60>:

Breakpoint 1, ©x080483aa in main ()
gdbs |

Stallman’s GDB
Input: faulty program and 1 failed test case
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Dynamic Slicing Example

Test Cases

2=

S:

8: else

9: if (x>y)

10: m=y;
1 fa B else if (x>z)
12 m = X;

} Pass/Fail |P ([P |P |P |P |F

Korel and Laski's dynamic slicing
Agrawal

Input: source code and failed test case
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FaSl DDD: /public/source/programmingiddd - 3.2/ddd/cxxtest.C 0O X
File Edit View Program Commands Status Source Data Help |
B ¢ — ] l':' ' ‘.
0:| “info all-registers® £ @ m» Break uucn Vz & Pt H«u# Ro?:te % URGED
‘.iEnt main(int /* & EVDIVEERTEEES X &m X
int i = 42; Run
r@ tree_test() Registers Interrupt
1+ eax: 0x401a2db8 1075457464
}ljt —test(i. ecx: 0x8043¢94 134519956 Step | Stepi |
- edx: 0x40131234 1075450420
Next | MNexti
?L[?"-“St(' ebx: 0x401a41b4 1075462580 Nt | ot
string_test: esp: Oxbfffef30 -1073746128 Until | Finish |
i+t ebp: Oxbfffefd48 -1073746104 Cont
plot_test(); esi: Oxbfffef34 -1073746028 ———J——J
R 0O; edi 0x1 1 Up | Down|
i ni eip: 0x8049cal 134519969 Undo| F-do |
cin_cout_tes eflags: 0x286 IOPL: O
retarn 0; | |f1ags: PF SF IF Edit | Mabe |
} orig_eax: OxFFFFFFFF |
cs: 0x23 35
] | SO
e gzggggg? & Integer registers + All registers i)
0xB8049cab «
0%8049calg «
0x80439cac «
0x8049caf « Close I Help l
0%8049¢ch0 < t) >
0xB8043¢chS «
0x8049¢ch8 <rain+36>: incl  Oxfrrrfffc(Xebp)
0%80439¢cbb <main+39>: call  0x8049428 <array_test(void)>
0xB049¢ccD maintd44>: incl  OxfFFFFffc(Xebp)
0x%8049¢c3 <maintd?>: call 0x8049404 <string_test(void)> -
(gdb) I
—t
A 2]

DDD
Input: faulty program and failed test case
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X,

T

Possible failure causes Set up first hypothesis Tos! first hypothess

Second hypothesis Thirg hypothesis Founh hypathess .

Delta Debugging
Input: faulty program, 1 failed and 1 passed test case
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The Berkeley/Stanford
Recovery-Oriented Computing (ROC)

\ Project

~e TARANT ULA

: \ Fault Localization via Visualization

— —

— — - -

. s

Statistical Debugging
Input: faulty program, test suite
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Existing Breakpoint
(correct & confident)

Existing Breakpoint
(not confident)

Existing Breakpoint
(wrong & confident)

Program r -
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Threats to the Validity and Value of Empirical
Assessments of the Accuracy of Coverage-Based
Fault Locators

Friedrich Steimann, Marcus Frenkel Rui Abreu
Lehrgebiet Programmiersysteme Department of Informatics Engineering
Fernuniversitat in Hagen Faculty of Engineering of University of Porto
Hagen, Germany Porto, Portugal
steimann@acm.org, marcus.frenkel@feu.de rui@computer.org
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Focus of this talk

* Jechniques that take into account spectra
* aka abstraction of program traces
e Spectrum-based Fault Localization (SFL)
- Statistical vs. reasoning

- Lightweight, scalable



SFL: Principle (1)

Test
suite

t1
t2
t3
t4
t5

—

11234567 ]8|9]10[11]12] M Not touched

o[ofofofoofofofofolo]o] W Touched, pass
B Touched, fail




SFL: Principle (2)

Test
suite

Status

t1 v
t2
t3
t4
t5

—

1]2[3]4]5|6]7]8|9]10[11]12] M Not touched

111ofofo[1T1[1[1[o[1[0] M Touched, pass
B Touched, fail




SFL: Principle (3)

Test Status
suite

t1 v

—) @
t3
t4
t5

- Not touched
- Touched, pass
- Touched, fail




SFL: Principle (4)

Te_st Status
suite

t1 v

::> t2 v

t3 «
t4
t5

1]2[3]4[5]6]7[8]9]10[11]12] | Not touched

2[1[1{ol1T2]2]2]2[*1[1[1] P Touched, pass
B Touched, fail




SFL: Principle (5)

Te_st Status
suite
t1 v
e
t3 «
t4 Vv
t5

1]2[3]4[5]6]7[8]9]10[11]12] | Not touched

s[1[r]o[1]3]3]2[3[*[3[3] MM Touched, pass
B Touched, fail




SFL: Principle (6)

Test
suite

Status

t1
:> t2
t3
t4
ts

< ¥ < X

1]2[3]4[5]6]7[8]9]10[11]12] | Not touched

s[1[r]o[1]3]3]2[3[*[3[3] MM Touched, pass
B Touched, fail




SFL: Principle (7)

Status

t1 v

Components are 2 v

ranked according to t3

the likelihood of x

causing detected errors t4 v

t5 «

1{2]3[4]5|6]7|8]9]10[11]12] | Not touched
311/0}13323133-

2]0jof2]1]2]2]0[2[1]0[0] B Touched, fail



Program

Test Suite

d“iiq;'"l“ri‘ﬂlet;{/;e Gint a, int b, int O { t1 | t2| t3| ta| ts | te |Suspiciousness

int type = SCALENE; ® 00O 0.09998
if (a=1Db)8&& (b = ) ) ® 00O 0.09998

type = EQUILATERAL; () 0.10001
else if ( (a*a) = ((b*b) + (c*O) ) 00 0.09999

type = RIGHT; o 0.10001
else if ( (a = b) |@ /% FAULT */ [ @ 0.10000

type = ISOSCELES; () 0.10001
return type; } ‘ ‘ ‘ . 0.09998

static double area(int a, intfp, int ) {

double s = (a+b+c)/2.0; C I 0.10000
return Math.sgrt(s*(s-a)*(s-b)*(s-c)); } ... } . ‘ 0.10000

*Fault™

Spectra

25



SUSPICIOUSNESS score

 Each component (row) is ranked according to their
similarity to the error vector

 Many similarity coefficients exist.

Ochiai(a, b) = cos(0)

a = {0,0,0,0,1,0)

* Ochiai similarity is equivalent to the cosine of the
angle between two vectors in a n-dimensional space

Abreu, R., Zoeteweij, P., Golsteijn, R., & Van Gemund, A. J. (2009). A practical evaluation of spectrum-based fault localization. Journal of Systems and Software, 82(11), 1780-1792.
Lucia, L., Lo, D., Jiang, L., Thung, F., & Budi, A. (2014). Extended comprehensive study of association measures for fault localization. Journal of Software: Evolution and Process, 26(2).



Diagnostic Performance

Ra.r?k Suspicious Statement Line Suspiciousness
Position number
1° type = EQUILAT 3 0.10001
2° type = RIG 0.10001
3° type = I( 0.10001
4° else if ( 0.10000
50 double s ="\ 0.10000
6° return Math.sqr.. 0.10000
7° else if ( (a*a) = ((b*b) + (c*c)) ) 4 0.09999
8° int type = SCALENE; 1 0.09998
Qo if(a=b& b=0c) 2 0.09998
10° return type; } 8 0.09998

R. Abreu, P. Zoeteweij, and A. J. van Gemund, “Spectrum-Based Multiple Fault Localization”, ASE '09



Can we do better?

o Statistics-based SFL does not reason in terms of
multiple faults

C1 C2 C3 P/F
1 0 0 1 (F)
0 1 0 1 (F)
1 0 1 1 (F)
0 1 1 1 (F)
1 1 0 0 (P)

Diagnostic report = < ¢3, €1, C2 >



Reasoning-based Approach

e Barinel is a reasoning-based approach

* Integrates the best of model-based diagnosis with spectra

C1 C2 C3 P/F
1 0 0 1 (F)
0 1 0 1(F)
1 0 1 1(F)
0 1 1 1(F)
1 1 0 0 (P)




Reasoning-based Approach

e Barinel is a reasoning-based approach

* Integrates the best of model-based diagnosis with spectra

C1 C2 C3 P/F
1 0 0 1(F)
0 1 0 1 (F)
1 0 1 1(F)
0 1 1 1(F)
1 1 0 0 (P)




Reasoning-based Approach

e Barinel is a spectrum-based reasoning approach

* Integrates the best of model-based diagnosis with spectra

so {c1,c2} is the only diagnosis possible

1 1 1(F)
1 0 0 (P)

A O 4 O




Spectrum-based reasoning

1. Generate sets of components that explain observed erroneous behavior
« Equivalent to compute minimal hitting set (Staccato/MHS2**)
e (Given failed executions

2. Rank candidates according to their probability of being the true fault
explanation » Baye'’s rule

« (Given both passed and failed executions

SFL

N
(" . (" ~- .
| Candidate Candldatew ﬁ Diagnostic
| Generation Ranking J . Report

R. Abreu, P. Zoeteweij, and A. J. van Gemund, “Spectrum-Based Multiple Fault Localization”, ASE '09
**https://github.com/npcardoso/MHS2 (citable via https://zenodo.org/record/10037) » contribute to the project; send pull requests; email us!



https://zenodo.org/record/10037

Diagnostic Performance
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% of faulty versions
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2013 IEEE International Conference on Software Maintenance

Theory and Practice, Do They Match?
A Case With Spectrum-Based Fault Localization

Tien-Duy B. Le, Ferdian Thung, and David Lo
School of Information Systems
Singapore Management University, Singapore
{btdle.2012 ferdianthung,davidlo} @smu.edu.sg

\
Abstract—Spectrum-based fault localization refers to the pro- Recently, Xie et al. [18] have theoreti &\’6{ .
cess of identifying program units that are buggy from two  many SBFL formulas. Their stud oo

sets of execution traces: normal traces and faulty traces. These formulascanbegmupedm &\q

approaches use statistical formulas to measure the suspiciousness Within each famil 0
of program units based on the execution traces. There have been ¥ L {\ (A
many spectrum-based fault localization approaches proposing 10 localize bug: 0&

various formulas in the literature. Two of the best ‘%

and well-known ones are Tarantula and Ochiai. Recently, Xie $
et al. [18) find that theoretically, undeteu'ulnmmpﬂou.

’rogram Spectrum Rainbow: Greatest Risk
fuation Formula Not Exist

November 3, 2014

Shin Yoo', Xiaoyuan Xie?, Fei-Ching Kuo®, Tsong Yueh Chen®, Mark Harman'

Affiliation: University College London!, Swinburn University?
E-Mail: xxie@swin.edu.au, dkuo@swin.edu.au, tychen@swin.edu.au

shin.yoo@ucl.ac.uk, mark.harman@ucl.ac.uk
e eee R ———




How good are we”

® Best Performing techniques still require to
inspect 10% of the code...

100 LOC » 10LOC
® 10,000 LOC » 1,000LOC
e 1,000,000 LOC » 10,000LOC E=7/{¢




Case Studies %

Case To Inspect
Load Problem 2 logical threads
Teletext Lock-Up 2 blocks

VM corrupt 96 blocks, 10 files 150K,
Scrolling Bug 5 blocks 150K
IS visible Pages hlocks 150K
" Tuner Problem | 1.8K

Zapping Crash 1 run (15 mins) 1 day (develop)
Wrong Audio 1 run (15 mins) /2 day (expert)

PHILIDS




Hum

® Are we properly quantifying Ic accuracy!?
® Comparing techniques base > rankings

® Assuming perfect bug unders ahdihg

® Are we showing providing an ecosystem offering
this techniques!?

iGatiagltl =0



Human Studies

Parnin & Orso et al observed that there is a lack of
human studies! (ISSTA’l I)

Are Automated Debugging Techniques
Actually Helping Programmers?

Chris Parnin and Alessandro Orso
Georgia Institute of Technology
College of Computing

{chris.parnin|orso}@gatech.edu

ABSTRACT

Debugging is notoriously difficult and extremely time con-
suming. Researchers have therefore invested a considerable
amount of effort in developing automated techniques and
tools for supporting various debugging tasks. Although po-
tentially useful, most of these techniques have yet to demon-
strate their practical effectiveness. One common limitation
of existing approaches, for instance, is their reliance on a
set of strong assumptions on how developers behave when

second activity, fault understanding, involves understanding
the root cause of the failure. Finally, fault correction is
determining how to modify the code to remove such root
cause. Fault localization, understanding, and correction are
referred to collectively with the term debugging.

Debugging is often a frustrating and time-consuming ex-
perience that can be responsible for a significant part of the
cost of software maintenance [25]. This is especially true for
today’s software, whose complexity, configurability, porta-
bility, and dynamism exacerbate debugging challenges. For

debugging (e. i'i the fact that examining a faulty statement

Acneb-arelmnispmtbemmmmt e A - = - - - -



Crowbar

— http://www.crowbar.io —
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User Study: Setup

® 40 participants
® |ntention: GZoltar vs. IDFE’s features
® Program: Xtream

e |7,389 LOC

® 306 classes and 22 packages

® [4]8 unit test cases

® |njected | logical fault

ouveia, C., Campos, J., & Abreu, R.. Using HTML5 visualizations in software fault localization. VISSOFT’13



User Study: Results

RQ1: Do the proposed visualizations efficiently aid the user to quickly find a fault?

1500

seconds
1000

- With Visualizations
——  Without Visualizations

0.0010 0.0012
I I

0.0008

Density
0.0006

500

0.0004

0.0002

0.0000
I

[ [
Without Visualizations With Visualizations 0 500 1000 1500 2000 2500

seconds



User Study: Results

RQ2: Is Crowbar a usable toolset?

Font's size/shape

Intuitive icons/buttons
Information clearly organized
Tasks quickly/easily executed
Usefulness of warnings
—GZoltar response speed

No user experience needed
IDE integration relevance
Importance of visual debugging
—GZottar global experience

0,00 1,00 2,00 3,00 4,00 5,00




Importance of Testing

class Triangle {..
static int type(int a, int b, int ) {

Suspicilousness

int type = SCALENE;

0.09998

“A cochuding factor for the

usefulness of SFL is the dependency on

the

/4

static double area(int a, int b, int ©) {

double s = (a+b+c)/2.0;

0.10000

return Math.sgrt(s*(s-a)*(s-b)*(s-c)); } ... }

0.10000



Diagnostic Performance

Ra.r?k Suspicious Statement Line Suspiciousness
Position number
1° type = EQUILAT 3 0.10001
2° type = RIG 0.10001
3° type = I( 0.10001
4° else if ( 0.10000
50 double s ="\ 0.10000
6° return Math.sqr.. 0.10000
7° else if ( (a*a) = ((b*b) + (c*c)) ) 4 0.09999
8° int type = SCALENE; 1 0.09998
Qo if(a=b& b=0c) 2 0.09998
10° return type; } 8 0.09998

R. Abreu, P. Zoeteweij, and A. J. van Gemund, “Spectrum-Based Multiple Fault Localization”, ASE '09



H(D) =— Y  Pr(dy) - logy(Pr(dy)), 0 < H < logy(M
di. €D

A. Gonzalez-Sanchez, R. Abreu, H.-G. Gross, and A. J. van Gemund, “Spectrum-Based Sequential Diagnosis”, AAAIl *11

14



Measuring Entropy

Ra.r?k Suspicious Statement Line Suspiciousness
Position number
1° type = EQUILATERAL; 3 0.10001
2° type = 5 0.10001
3° type = 001
4° else 1 Y0
5o doubl¢ H = 3 u 3 2 2 )0
6° return . ~J000
7° else if (O J : (c*c)) ) 4 0.09999
8° int type = SCALENE; 1 0.09998
Qe if(@=b)& b =0 ) 2 0.09998
10° return type; } 8 0.09998

15



The variety of test cases is the
major factor to have
uncertainty in the ranking



Density of a Test Suite

d“iiq;'"l“?ﬁletf/;e Gint a, int b, int O { t1 | t2| ts | ta | ts | ts |Suspiciousness

int type = SCALENE; o 0.09998
if ((a—=1b)8 (b= <)) @ 0.09998

type = EQUILATERAL: 0.10001
else if ( (a*a) = ( 0.09999

type = RIGHT; 0.10001
else if ( (a = b) | 0.10000

type = ISOSCELES; 0.10001
return type; } 0.09998

static double area(int a, int b, int ) {

double s = (a+b+c)/2.0; ‘ ‘ 0.10000
return Math.sqgrt(s*(s-a)*(s-b)*(s-c)); } ... } . ‘ 0.10000

A. Gonzalez-Sanchez, R. Abreu, H.-G. Gross, and A. J. van Gemund, “Prioritizing tests for fault localization through ambiguity group reduction”, ASE '11 17
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D

IG(p) = —p-loga(p) — (1 = p) - logy (1 — p)

R. A. Johnson, “An information theory approach to diagnosis”, IRE Transactions on Reliability and Quality Control, no. 1, pp. 35-35, 1960
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A fitness function based on
entropy to guide search-based
test generation and to optimize
the quality of ranking reports



ENTBUG

EvoSuite > new test (t)

no yes

Campos, J., Abreu, R., Fraser, G., & d'Amorim, M. Entropy-based test generation for improved fault localization. ASE'13.

0.5 — p(T U {t})| —> add to the test suite

20



S T+ {ts, te} T+ {t, ts, to)
P =0.500
class Tlr‘ialjlgle L. : : . shess | tg 9 | Suspiciousness| to 2 | Suspiciousness
static int type(int a, int b, 1m : i i
int type = SCALENE; 8|  0.09998 0.03629 6| 002354 |@i5| 004347
if(@—=b)8& b=0) 9| 009998 |@i7| 003620 |@ 7| 002354 |@ 6| 004347
type = EQUILATERAL; 1| 0.10001
else if ( (a*a) = ((b*b) + (c*)) ) 7| 0.09999 0 5| 0.08466 3| 010983 |@ 2| 017391
type = RIGHT; 2| 0.10001 1| 0.29033 1| 0.37666
elseif ((a=0b) Il (b = */ |4| 010000 |@i2| 017204 2| 022320 |@i1| 034782
type = ISOSCELES;
return type; } 8 0.02354 Q 7 0.04347
static double area(int a, int
double s = (a+b+c)/2.0; s 0.10000 0.17204 4| 010983 |@i3| 0.17391
return Math.sgrt(s*(s-a)*(s-b)*(s=e)); } ... } 6| 0.10000 0.17204 5| 010983 |@i4| 0.17391
Test case outcome (pass = ¢/, fail =X) ' )(
P 0.400 0.457 0.475 0.500
H 3.322 2.651 2.445 2437
Cy Q 1.000 0.000
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® Available as an Eclipse plug-in

® aVisual Studio plugin will
be released soon

® Also available as a library

® |nhstrumentation and
diagnosis

® Testing features are yet to be
deployed

® Only test suite
minimization available
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| et's use It

Open Eclipse
Install Crowbar
® Help » Install New Software

® http://crowbar.io/plugin/tarot/

® Window » Other... » Crowbar Views » Diagnostic Reports

Import (as maven project) buggy yodaTime

® http://crowbar.io/plugin/tarot/buggy yodatime.zip

Find the bug! L;«’;*
i


http://crowbar.io/plugin/tarot/
http://crowbar.io/plugin/tarot/

Opportunities and Challenges

® |ntegration with software repository mining

® Use fitness function in test suite prioritization and
minimization

® Generation: How to solve the oracle problem?
® Human in the loop

® AutoSeer project: leverage program invariants

® Explore idiosyncrasies of mobile devices



Software Errors mentioned in Ada Byron's notes on Charles
Bababage's analytical engine

Test
suite
t1
2
3
t4
t5

SFL: Principle (1)

[ == |

HEHE

010 W TYouched, pass
- Touched, fail

r r T 1 T
P I ylalslael?Talaoliclnlz s

| 131 ! ! l 12 . Not touched
0I010]0|01010]0]0]0]0}0

B ‘o4 + ‘4 +—
0 ;‘ 0j0|0j0]0]0}0 |v, 0

® Are we properly quantifying
e Comparing techniques base rankings

® Assuming perfect bug under:

® Are we showing providing an ecosystem offering
this techniques?

TV N—

uestions”

Importance of Testing

“A confounding factor for the

usefulness of SFL is the dependency on
the o

® Available as an Eclipse plug-in

® aVisual Studio plugin will
be released soon

e Also available as a library

® Instrumentation and
diagnosis
¢ Testing features are yet to be
deployed

® Only test suite
minimization available

Let’s use it!

¢ Open Eclipse

Install Crowbar
®  Help > Install New Software

¢ hupdicrowbariofplugin/tarot/
* Window » Other... » Crowbar Views » Diagnostic Reports
® Import (as maven project) buggy yodaTime
*  httpdicrowbacio/plupin/tarot/buggy yodatime.zip
Find the bug! |
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